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CHAPTER 1

Working with EDLs

This chapter introduces edit decision lists (EDLs) and provides 
instructions for basic EDL Manager procedures. It includes the 
following sections:

• EDLs and the EDL Manager

• Starting EDL Manager

• Using Help

• Creating or Reading an EDL

• Saving an EDL

• Formatting an RT-11 Disk

• Printing an EDL

• Copying an EDL Between Storage Locations

• Using EDL Manager with Your Avid Editing System

• Viewing a List of Tapes in the Source Table
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EDLs and the EDL Manager

An edit decision list (EDL) is a list of instructions for all the edits you 
make for creating a program on videotape. This list might include cuts, 
wipes, dissolves, fades, and black edits. The EDL Manager application 
organizes the instructions as a series of chronological edits called 
events. Each event specifies a timecode for the source and master tapes.

Online and Offline Editing

In most cases, you generate an EDL to take a project from the offline 
editing environment, where rough editing and experimentation are less 
expensive, into the online editing environment, where an editor using 
an edit controller can produce a finished master in less time. The EDL 
Manager saves EDLs in a format an editing system can use, such as 
GVC or CMX. You might also need to import an EDL from the online 
environment back into the offline suite to make further changes before 
completing the master tape.

Traditionally, the offline environment consisted of a simplified 
videotape suite with less expensive machines and fewer effects 
capabilities. More recently, offline environments are likely to include 
nonlinear editing systems such as Avid’s Media Composer®. The online 
environment might also include a high-end nonlinear editing system 
such as Avid’s Symphony™, or an online model of Media Composer.

In all cases, the EDL, in the form of a file generated in a readable 
format, is the link back and forth between the two environments.

What the EDL Manager Does

You can use EDL Manager to generate an EDL from a sequence in a bin 
or from an OMFI file. OMFI is a file format for importing and 
exporting media; it allows you to share information with other 
platforms. You can also read a previously saved EDL into EDL 
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Manager. After creating an EDL, you can save it as a text file that can 
be read by different edit controllers, such as Sony®, GVG, or CMX, or 
you can save the EDL as an OMFI composition.

You can use EDL Manager to create an EDL that displays additional 
types of information, such as comments or patches. You can specify the 
different audio and video tracks in the sequence. You can also specify 
the assembly modes that the online edit controller uses when creating 
your program. 

Because EDL Manager is a standalone application, your other Avid 
applications do not have to be running when you create EDLs from 
sequences. When you run EDL Manager with your Avid editing 
system, you can bring the sequence that is currently in the editing 
system into the EDL Manager window. After working with the EDL in 
EDL Manager, you can create a sequence in the Avid editing system 
from the EDL.

Starting EDL Manager

You can start EDL Manager as a standalone application, or you can 
start it from within your Avid editing system application.

(Windows) To start EDL Manager as a standalone application:

1. Click the Start button.

2. Point to Programs.

3. Point to Avid.

4. Point to EDL Manager.

EDL Manager starts.
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(Macintosh) To start EDL Manager as a standalone application:

t Double-click the EDL Manager icon. 

EDL Manager starts.

To start EDL Manager from within your Avid editing system 
application:

t Choose EDL from the Output menu.

EDL Manager opens as the active window, showing the Editing 
System icon connected to the Update button by a Right Arrow button.

Using Help

The Help provides all the information contained in Avid EDL Manager 
User’s Guide, and operates in a web browser. To open the Help, choose 
EDL Manager Help from the Help menu in the Avid EDL Manager 
application. For information about using the Help, click the Using 
Help button in the Help system.

Creating or Reading an EDL

The EDL Manager window displays the EDL you create or the existing 
EDL you open or read. You can view an EDL by doing any of the 
following:

• Creating an EDL from a Sequence in a Bin, Existing EDL, or OMFI 
File (Macintosh).

• Creating an EDL from the Active Sequence.

• Reading an Existing EDL from the RT-11 Disk.
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Creating an EDL from a Sequence in a Bin, Existing EDL, 
or OMFI File (Windows)

To create an EDL from a sequence in a bin, from an existing EDL, or 
from an OMFI file:

1. Choose Open from the File menu.

The Select File to Open dialog box appears.

2. Choose Common Files (*.avb, *.edl, *.omf) from the Files of type 
pop-up menu.

3. Navigate to the disk or folder that contains the file you want.

4. Select a file — either a sequence in a bin (.avb), another EDL (.edl), 
or an OMFI (.omf) file — and click Open.

n When you open an OMF file or a file from a bin, EDL Manager automatically 
determines whether the EDL you are generating should be NTSC, PAL Video, 
or PAL Film 1 or 2. If you open an EDL other than from an OMF file or a file 
from a bin, you must select a standard suboption.
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If you select a bin or an OMFI file, one of the following happens:

• If the file contains only one sequence, EDL Manager creates 
the EDL for that sequence. 

• If the file contains more than one sequence, the Open dialog 
box appears.
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5. Select a sequence and click OK. 

The created EDL appears in the EDL Manager window. 

n The Source and Output pop-up menus appear only for 24p or 25p bins and 
for OMFI files. 

For information on changing the settings in the EDL, see Chapter 2.

Creating an EDL from a Sequence in a Bin, Existing EDL, or 
OMFI File (Macintosh)

To create an EDL from a sequence in a bin, from an existing EDL, or 
from an OMFI file:

1. Choose Open from the File menu.

A dialog box appears.

2. Navigate to the disk or folder that contains the file you want.

3. Select a file — either a sequence in a bin (.avb), another EDL (.edl), 
or an OMFI (.omf) file — and click Open.
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n When you open an OMF file or a file from a bin, EDL Manager automatically 
determines whether the EDL you are generating should be NTSC, PAL Video, 
or PAL Film 1 or 2. If you open an EDL other than from an OMF file or a file 
from a bin, you must select a standard suboption.

If you select a bin or an OMFI file, one of the following happens:

• If the file contains only one sequence, EDL Manager creates 
the EDL for that sequence. 

• If the file contains more than one sequence, a dialog box 
appears. Select a sequence, and then click OK. EDL Manager 
creates the EDL. 

The created EDL appears in the EDL Manager window.

n The Source and Output pop-up menus appear only for 24p or 25p bins and 
for OMFI files. 

For information on changing the settings in the EDL, see Chapter 2.
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Reading an Existing EDL from the RT-11 Disk

(Windows) To read an EDL that is saved on an RT-11 disk in a CMX, 
GVG, or high-density GVG (HDGVG) edit controller format:

1. Insert the RT-11 disk that contains the EDL you want to read into 
the disk drive. 

2. Choose Read From RT11 Disk from the File menu.

The Open dialog box appears.

3. Select the EDL you want and click OK.

The EDL opens in the EDL Manager window.

n When you open an OMF file or a file from a bin, EDL Manager automatically 
determines whether the EDL you are generating should be NTSC, PAL Video, 
or PAL Film 1 or 2. If you open an EDL other than from an OMF file or a file 
from a bin, you must select a standard suboption.
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(Macintosh) To read an EDL that is saved on an RT-11 disk in a CMX, 
GVG, or high-density GVG (HDGVG) edit controller format:

1. Insert the RT-11 disk that contains the EDL you want to read into 
the disk drive. 

An alert box warns that the disk is not a Macintosh disk. 

2. Click OK. 

A Disk icon appears in the main window. 

3. Choose Read From RT11 Disk from the File menu.

A list of EDL files appears.

4. Select the EDL you want and click OK.

The EDL opens in the EDL Manager main window.

n When you open an OMF file or a file from a bin, EDL Manager automatically 
determines whether the EDL you are generating should be NTSC, PAL Video, 
or PAL Film 1 or 2. If you open an EDL other than from an OMF file or a file 
from a bin, you must select a standard suboption.

To eject the RT-11 disk:

t Choose Eject RT11 Disk from the File menu.

Disk icon
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Saving an EDL
You can save an EDL as a text file with the .EDL file name extension, or 
as an OMFI composition. The location where you save the EDL can be a 
DOS-formatted disk, a hard drive or other storage device, or an RT-11 
disk that can be read by CMX or GVG edit controllers. For information 
on formatting an RT-11 disk, see “Formatting an RT-11 Disk” on 
page 22.

Saving an EDL as a Text File or an OMFI Composition

To save an EDL as a text file or an OMFI composition:

1. Choose one of the following from the File menu:

• Save As, to save the EDL as a text file

• Save As OMFI, to save the EDL as an OMFI composition

A dialog box appears.

2. Navigate to the disk or folder where you want to save the EDL.

3. Accept the default file name, or enter a new name.

If you are saving to a DOS-formatted disk for transfer to an edit 
controller, use a file name that the edit controller can read. The 
name must be eight alphanumeric characters or less in uppercase 
letters, followed by the file name extension (either .EDL or .OMF). 
For example:

ANNA23.EDL

4. Click Save.

EDL Manager saves the EDL to the location you specified.
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Saving an EDL to an RT-11 Disk

(Windows) To save an EDL to an RT-11 disk:

1. Insert a CMX or GVG disk into the disk drive.

2. With an EDL open in the EDL Manager window, choose Write To 
RT11 Disk from the File menu.

The Save As dialog box appears, showing the name of your EDL.

3. Accept the EDL file name, or type a new name.

The name must be six or fewer alphanumeric characters, in 
uppercase letters, followed by the .EDL file name extension. 
For example:

LEO3A.EDL

4. Click OK.

EDL Manager saves the EDL to the CMX or GVG disk.

n Some edit systems cannot read high-density disks (marked with the HD 
symbol), so you might have to use a double-density disk. If you are in doubt, 
check with the online suite or have the suite provide you with a formatted 
disk.
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(Macintosh) To save an EDL to an RT-11 disk:

1. Insert a CMX or GVG disk into the disk drive.

An alert box appears.

2. Click OK.

3. With an EDL open, choose Write To RT11 Disk from the File menu.

The Save As dialog box appears, showing the name of your EDL.

4. Accept the EDL file name, or type a new name.

The name must be six or fewer alphanumeric characters, in 
uppercase letters, followed by the .EDL file name extension. 
For example:

LEO3A.EDL

5. Click OK.

EDL Manager saves the EDL to the CMX or GVG disk.

n Some edit systems cannot read high-density disks (marked with the HD 
symbol), so you might have to use a double-density disk. If you are in doubt, 
check with the online suite or have the suite provide you with a formatted 
disk.
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Verifying an RT-11 Save
Because an RT-11 disk is not initialized for Macintosh or Windows, 
you cannot see its contents by using the standard operating system 
tools (for example, My Computer on Windows). To verify that the EDL 
has been saved successfully to the disk, follow the steps in “Reading 
an Existing EDL from the RT-11 Disk” on page 17. If the EDL appears 
in the Make Selection dialog box, then you know it was saved to the 
disk.

To verify that the EDL was saved to the disk:

1. Choose Read From RT11 Disk from the File menu.

The list of files for the RT-11 disk appears, allowing you to verify 
that your EDL was saved to the disk.

2. Click Cancel to return to the EDL Manager.

Formatting an RT-11 Disk

An RT-11 disk in EDL Manager can be in any of the following formats:

• CMX

• GVG

• HDGVG (high-density GVG)

c When you take a DOS or Macintosh-formatted disk and format it as 
an RT-11 disk, data on the disk is erased.

To format an RT-11 disk:

1. Choose Format RT11 Disk from the File menu.

A dialog box appears, telling you to insert a diskette.

2. Insert a DOS-formatted disk (Windows) or a blank disk 
(Macintosh) into the drive and click OK.
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A message box appears, warning that all data on the disk will be 
lost.

3. Click OK.

A dialog box appears.

4. Click one of the option buttons to choose an EDL disk type format.

EDL Manager formats the disk.

Printing an EDL

To print an open EDL:

1. Choose Print EDL (Windows) or Print (Macintosh) from the File 
menu.

A dialog box appears.

2. Select the print options you want.

3. Click OK (Windows) or Print (Macintosh).

Copying an EDL Between Storage Locations

You can copy an EDL from any drive or disk storage location to 
another without having to open the EDL in the EDL Manager window 
or switch to operating system tools such as My Computer. The storage 
locations, including RT-11 disks, must be accessible to your computer.
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To copy an EDL from one location to another:

1. To copy to or from an RT-11 disk, insert the RT-11 disk in the disk 
drive. 

(Macintosh only) A message appears stating that this is not a 
Macintosh disk.

2. Click OK.

3. Choose Copy To/From Disk from the File menu.

A dialog box appears.

4. To select the EDL to copy, do one of the following:

• To copy from an RT-11 disk, click Yes.

A list of EDL files appears. Select the EDL you want and click 
OK.

• To copy from any other disk or drive, click No.

A dialog box appears.

• Navigate to the file you want to open and click Open.

Once you have selected the EDL you want to copy, a dialog box 
appears asking if you want to write to an RT-11 disk.

5. To select the destination for the EDL copy, do one of the following:

• To copy to an RT-11 disk, click Yes, either accept the default 
file name or enter a new name of six or fewer uppercase 
characters, and then click OK.

• To copy to any other disk or drive, click No.

A dialog box appears. 
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• Navigate to the location where you want to save the file and 
click Save.

Using EDL Manager with Your Avid Editing System

EDL Manager is a standalone application; your other Avid editing 
applications (for example, Media Composer, Film Composer, 
Symphony, Avid Xpress, or Avid Xpress DV) do not have to be 
running when you create EDLs from existing sequences. 

When you start EDL Manager from your Avid editing system, or have 
EDL Manager and the editing system running at the same time, you 
can create an EDL for the sequence loaded in the active monitor or you 
can create a sequence in the Avid editing system from an EDL that is 
open in EDL Manager. See the following sections for more 
information:

• Creating an EDL from the Active Sequence 

• Creating a Sequence from an EDL

Creating an EDL from the Active Sequence

You can create an EDL directly from the sequence that is loaded in 
your Avid editing system. For more information, see “Using EDL 
Manager with Your Avid Editing System” on page 25.

To create an EDL from the sequence currently loaded in the Avid 
editing system, do one of the following in EDL Manager:

t Click the Right Arrow button between the Editing System button 
and the Update button in the EDL Manager window.

t Choose Get Current Sequence from the File menu.
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The EDL appears in the EDL Manager window and a Left Arrow 
button appears under the Right Arrow button, indicating that you can 
now also create a sequence from the EDL.

Creating a Sequence from an EDL

You can create a sequence in your Avid editing system directly from an 
EDL. This procedure only applies to 30i and 25i projects and 
sequences.

To create a sequence in your Avid editing system from an EDL that 
is open in EDL Manager:

1. With your Avid editing system running, do one of the following:

t Click the Left Arrow button between the Editing System 
button and the Update button in the EDL Manager EDL 
Manager window.

t Choose Create Composer Sequence from the EDL Manager 
File menu.

The editing system becomes the active window, and a dialog box 
appears. The dialog box lists only those bins currently open in the 
editing system.

2. Do one of the following:

t Select an existing bin in which to place the EDL sequence, and 
then click OK.

t Click New Bin to create a new bin in which to place the EDL 
sequence.

The sequence is created in the bin you selected, and EDL 
Manager becomes the active window again.
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Viewing a List of Tapes in the Source Table

The source table lists all source tapes in the sequence that the EDL 
describes. The source table is a useful reference when you assemble 
your program. 

To view the source table:

t Click the Sources button in the EDL Manager window. A list of 
source tapes appears.

n If Sources is already selected before you open an EDL, the source table appears 
when you complete the opening procedure. To view the master EDL display, 
click Master in the EDL Manager window.

The source table has one row for each source tape. The three columns 
provide the following information:

• The user-defined name for a source tape

• The Avid-defined name for a source tape

• The Avid import ID, which is the internal identification for your 
Avid source tape

User-defined
name

Avid-defined
name

Avid import ID
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The exact format for these columns varies depending on the format of 
your EDL.

Before your online session, you might want to print the source table on 
paper. 

Printing a List of Tapes in the Source Table

To print the source table:

t Choose Print EDL from the File menu. 

For more information about the online session, see “Online and 
Offline Editing” on page 10.

User-defined
name

Avid-defined
name

Avid import ID
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CHAPTER 2

Customizing EDLs 

This chapter describes how to customize an edit decision list by 
changing a variety of settings. It also explains how to save settings as 
templates for use with other EDLs.

This chapter includes the following sections:

• EDL Manager Option Settings

• Changing Settings in the EDL Manager Window

• Changing Settings in the Options Window

• Changing Options in the Site Settings Dialog Box

EDL Manager Option Settings

Initially, EDL Manager uses default option settings to generate the 
EDL, unless you customize the EDL by changing the settings for any 
of the options. You can change the settings, save them to a template, 
and then use the template for other EDLs; or you can continue to 
manipulate the settings until you find the most effective combination 
for your sequence. 
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Settings that you can change are located in several places within EDL 
Manager. See the following sections:

• Changing Settings in the EDL Manager Window

• Changing Settings in the Options Window

• Changing Options in the Site Settings Dialog Box

As you choose the settings for your EDL, remember that they might 
significantly affect the online session in terms of time and money. For 
example, if you finish your program in a suite with preread 
capabilities, choosing the preread option in the EDL Manager 
application can save time in dubbing sources, and save money in 
additional deck rental.

Changing Settings in the EDL Manager Window 

Use the EDL Manager window (see Figure 2-1) to change or select the 
following settings:

• Title name of your EDL

• Video tracks and audio channels

• Views of the EDL — master list, dupe list, or source table

• Templates to apply to the EDL

• Source and output frame rates (for 24p or 25p bins and OMFI files 
only)

Use the Update button to update the EDL with changes you make to 
the video tracks, audio channels, title, and to the Source and Output 
frame rates.
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Figure 2-1 EDL Manager Window

Changing the Title of an EDL

You can change the title of your EDL at any time. For example, you 
might want to open an EDL, modify it in some way, and then retitle 
the modified version to distinguish it from the original. If you then 
save the new version by using a new file name, you have two distinct 
versions of the EDL with different titles and file names.

EDL

Video and Audio 
Track selector panel

EDL name Three views
Update button

Source timecode Output timecode

Timecode options 
(24p, 25p and OMFI files only)



32

To change the title of an EDL:

1. Click in the Title text box.

2. Delete the old title and type a new one.

3. Click Update.

The new title appears as the first line of the EDL.

n Changing the title of an EDL does not automatically create a new file. To 
create a new file, you must save the EDL by choosing Save As from the File 
menu. In the Save As dialog box that opens (for an EDL with a changed title), 
the system supplies a new file name by default — the first six characters of the 
new name plus the .EDL file name extension. You can accept this file name or 
modify it before you save the EDL.

Defining Video Tracks and Audio Channels

EDL Manager works with a maximum of 24 video tracks and 16 audio 
channels, depending on the edit controller format you select, as 
described in “Changing Settings in the Options Window” on page 42. 
The capabilities of the edit controller determine how many output 
tracks (channels) you can use.

The Track Selector panel in the EDL Manager window controls the 
selection of video and audio tracks for the EDL. Each button in the 
panel represents one channel of audio or video in the EDL.

Initially, EDL Manager uses the following panel configuration:

The number on each button refers to the channel from the sequence 
that is assigned to that channel in the EDL.

Audio channelsVideo track
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If you create an EDL from a simple sequence that contains one video 
track and up to four audio channels, you can use the default 
arrangement of the Track Selector panel. For other situations, you can 
reconfigure the Track Selector panel differently.

Including or Excluding Specific Tracks

If multiple audio channels and video tracks exist in your sequence, 
you might want to include only certain tracks in the EDL. 

To specify which tracks to include or exclude:

1. Click the audio or video track button in the Track Selector panel.

A pop-up menu of channels (or tracks) appears. The number of 
audio channels listed depends on your edit controller.

2. Do one of the following:

t Choose a track number from the pop-up menu.

t Choose the minus sign (–), at the top of the pop-up menu, to 
turn off a track.

The track number or the minus sign appears on the button.

3. Click Update.

Redefining a Track

You can assign any track from your sequence to any track in your EDL. 
Keeping channel A1 in the sequence as the first audio channel in the 
EDL is not necessary.

For example, suppose you decide to move audio channel 16 in your 
sequence to audio channel 1 in your EDL. Choose A16 from the 
pop-up menu.

The underlined number in the list of available tracks — in this case, A1 
— is a reminder that you are moving A16 to the EDL audio channel 1.
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The audio button displays A16, indicating that you have assigned 
track A16 from the sequence to the first audio channel in the EDL.

When you generate your list, the EDL will refer to this channel as A1 
because it is the first audio channel in the EDL itself.

EDL
channels 

Track selected to
include in the EDL

Track displayed
in the EDL
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Combining or Isolating Tracks

Depending on the complexity of your sequence, you can combine or 
isolate video tracks.

• For simple sequences, you can combine video tracks. To do so, 
choose the All V (All Video) setting from the Video Track pop-up 
menu. EDL Manager combines all the video tracks in a sequence 
into one representative video track in the EDL.

When you combine video tracks and the list is too complex, EDL 
Manager simplifies the list. To see error messages, choose Console 
from the Windows menu. For more information on the Console 
window, see “Removing Problems Caused by Complex 
Sequences” on page 65.

• For sequences too complex to be represented in one EDL, you can 
isolate a video track. 

As an example, you might have multiple layers of keys, or a key 
over a superimposition (super) with color correction, and so on.

Track isolation creates successive EDLs for the same sequence, 
each with a different video track.

To isolate a video track: 

1. Assign a single video track from the sequence, such as V1, to the 
EDL Manager video track.

2. Save this EDL with a unique name.

Repeat the steps for each video track you want to isolate.

c When you save successive EDLs for the same sequence, be sure to 
devise a system for giving each file a unique name, such as 
SOURCE1.EDL, SOURCE2.EDL, and so on.

Creating Stereo Channels

By assigning the same audio channel from your sequence to two 
different EDL Track Selector panels, you can create stereo channels. 
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For example, to create stereo channels using A16 from your sequence, 
assign A16 to both audio tracks 1 and 2 in EDL Manager:

To create stereo channels:

1. Click an audio button in the Track Selector panel.

2. Choose the audio channel in the sequence from which you want to 
create a stereo channel.

3. Click another audio button.

4. Choose the same audio channel from the sequence to assign to this 
EDL channel.

5. Click Update.

Choosing a Format for the Audio Channels

Your EDL can include a maximum of 16 audio channels at any one 
time in the EDL, depending on the edit controller format you chose. 
For information on choosing an edit controller format, see “Selecting 
an Edit Controller Format” on page 44.

Displaying Different Views of an EDL

Your EDL Manager window can display the EDL in one of three ways:

• Master list

• Dupe list (if options are set for creating a dupe list)

• A table of your source tapes
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To display one of the views in the EDL Manager window:

t Click the button of the view you want to see.

For more information, see “Setting Up a Master List” on page 48, 
“Setting Up a Dupe List” on page 50, and “Viewing a List of Tapes in 
the Source Table” on page 27.

Selecting a Template for the EDL

A template file is where you can save a customized set of options. This 
feature allows you to organize and recall the customized settings in 
whatever way is useful for your work. For example, you might want 
to create a template for each editor who works on your system, or 
perhaps create a template for each type of edit controller you regularly 
work with.

File Names in the Template Pop-up Menu

The Template pop-up menu lists the name of the current template 
your EDL is using and any other templates you have saved. It also lists 
any temporary template, shown as an italicized file name. 
EDL Manager automatically creates the temporary file as you make 
and apply changes in the Options window (see Figure 2-2). To save 
your customized options to a template, see “Saving Options to a 
Template File” on page 61.
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Opening a Template

To open an existing template or a temporary template:

1. Click the Template pop-up menu.

A list of templates appears.

2. Choose the template you want to open.

EDL Manager loads the option settings associated with the 
template. To see the options that are set for this template, open the 
Options window by choosing Options from the EDL Manager 
Windows menu. The name of the template appears in the 
Template Name text box in the Options window. 

Adjusting the Source and Output Timecodes

You can deliver various output formats in 24p and 25p projects by 
adjusting the timecodes in your EDL. The Source and Output pop-up 
menus, in the EDL Manager Window, each list timecode options that 
you can set for the EDL. The Source and Output options you choose 
affect the source and output timecode columns of the EDL (see 
Figure 2-1).

n The Source and Output pop-up menus appear in the EDL Manager window 
only when you read in a sequence from a 24p or 25p project or from an OMFI 
file. 

If you are not working with a 24p or 25p project, set the timecodes in 
the Timecode Type pop-up menu in the Master List pane of the 
Options window. For information on the Timecode Type pop-up 
menu, see Table 2-5.

n Setting the timecodes in the Master List pane for 24p and 25p projects has no 
effect on your EDL; you must use the Source and Output pop-up menus to 
set timecodes for 24p and 25p projects.
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To adjust source and output timecodes for 24p and 25p projects and 
OMFI files:

1. Choose Open from the File menu. 

2. Select a 24p or 25p project sequence from a bin or select an OMFI 
file. 

The EDL automatically loads into the EDL Manager window and 
the Source and Output pop-up menus appear.

3. Choose a frame rate option from the Source pop-up menu, the 
Output pop-up menu, or from both. Table 2-1 explains the options. 

EDL Manager adjusts the frame rates and displays the new 
timecodes in the source and output timecode columns of the EDL.

Source timecodes Output timecodes

Source 
pop-up menu

Output 
pop-up menu
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4. Click the Update button. EDL Manager displays the new 
timecodes in the EDL.

Finding the Field Where an Edit Occurred

While field dominance is generally consistent for video-originated 
material, the pulldown of the film transfer determines field dominance 
for 24p and 25p material. This field information, which is important 
for color correction of 24p and 25p material, is indicated in the 
timecode display. 

Table 2-1 Source and Output Timecodes

Source Timecodes Output Timecodes Description

Start (LTC) — The longitudinal timecode

VITC — The vertical interval timecode

Sound TC — The sound timecode, such as 
DAT or Nagra

Film TC — The film timecode from the film 
source in your bin

Aux 1–5 TC — The timecode from the timecode 
column in the bin

24 TC 24 TC 24 fps 

25pd TC 25p TC 25 fps with pulldown

25 TC 25 TC 25 fps

30 TC 30D 30 fps drop frame

30ND 30 fps non-drop-frame
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The timecode format is as follows:

hh:mm:ssQff

Table 2-2 explains how Q indicates the timecode format and field.

Updating an EDL with EDL Manager Window Changes

Changes you make to the Track Selector panel or to the Source and 
Output pop-up menus do not take effect until you update the EDL. 

To update the EDL with these changes:

t Click the Update button. 

The Update button flashes to indicate when you should update.

Table 2-2 Timecode Format

Symbol Example Field Timecode Format

. (period) 04:50:25.05 Field 1 Non-drop-frame

: (colon) 04:50:25:05 Field 2 Non-drop-frame 

, (comma) 04:50:25,05 Field 1 Drop frame 

; (semi-colon) 04:50:25;05 Field 2 Drop frame
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Changing Settings in the Options Window

You can further customize your EDL by defining options in the EDL 
Manager Options window. You can set the following options:

• Format of the edit controller

• Sort mode

• Master list characteristics

• Dupe list/preread characteristics

• Show or hide options

• Optimization types

• Standards settings

• Record start time settings

• Saving options to a template file

n EDL Manager initially uses default settings to generate your EDL, if you do 
not customize the EDL. For any subsequent EDL, EDL Manager uses 
settings from the previously generated EDL, unless you specify a template of 
settings to use. 

To change the option settings:

t Choose Options from the EDL Manager Windows menu. 

The Options window opens in EDL Manager (see Figure 2-2). The 
name of the template you are using appears in the Template Name text 
box. 
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Figure 2-2 Options Window

In the Windows 2000 operating system, the EDL Manager check 
boxes now have a slightly rounded look. Their functionality, 
however, remains the same as in previous Windows versions. 

n
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Selecting an Edit Controller Format

For information on 
going to the online 
suite, see Appendix A.

EDL Manager needs to know the format and version number of your 
edit controller. If you do not select a format, EDL Manager uses format 
CMX_3600, which is the most common format. Table 2-3 lists the 
available edit controller formats and the number of audio channels 
that each format supports.

n Check with your online house before you make an edit decision list. As a 
backup, always create a list based on the CMX_3600 format — it is the most 
common format. Otherwise, create several lists in different formats with 
distinct titles and file names. You will be prepared in case your list will not 
load or you are moved to another editing room at the last minute.

Selecting an Edit Controller Format

To choose a format:

1. Click the Format pop-up menu to open it.

2. Choose a format.

3. Click Apply.

n A format might be available in several versions. For example, Avid supports 
GVG 4.1 and GVG 7.0 formats. 
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Table 2-3 explains the formats.

Table 2-3 Formats and Audio Channels

Format Number of Audio Channels

Abekas Solo (ASCII) 2

Ace 25 2

Ace_25_4.1_4.1 2

AmpexACE 200_9.10.03 4

Avida 16

CMX_340 2

CMX_3600 4

CMX_DigitalCut 4

CMX_Pulldown 4

CMX_Transfer 4

Cuedos_1 16

GVG_4.1_6.0 4

GVG_7.0_7.0 4

Paltex 2

Sony_5000 2

Sony_9000 1.0_2.21 4

Sony_9000 2.22_2.32 4

Sony_9100 1.02_1.04 4
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n If you mix down audio channels, EDL Manager does not represent them 
properly in an EDL. Once audio channels are mixed down, EDL Manager 
does not have a source to associate them with, and therefore cannot find the 
timecode values it needs to create a list.

Sorting the Order of Events

To minimize the amount of time the edit controller spends shuttling 
linear tapes, you can choose the appropriate sort mode. Sort mode 
affects only the order of the events and not their content. Table 2-4 
describes the different ways you can use each mode. 

c Do not select a sort mode and then expect to change it again in the 
online session unless you have EDL Manager installed at the site. 
Some edit controllers cannot re-sort an EDL.

Sony_9100 1.1_2.11 4

Sony_DigitalCut 4

Sony_Pulldown 4

Sony Transfer 4

a. Avid is not available as a selection from the Format menu. 
However, you might want to generate an EDL for further use with 
an Avid editing system. In this case, you can preserve up to 16 
channels of audio information by choosing 16 from the Audio 
Channels pop-up menu in the Standards option pane (see “Setting 
Up Standards” on page 57).

Table 2-3 Formats and Audio Channels (Continued)

Format Number of Audio Channels
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To choose a sort mode for your EDL:

1. Click the Sort Mode pop-up menu to open it.

2. Choose a sort mode.

3. Click Apply.

n Choose mode A if you are unsure about which sort mode to use.

Table 2-4 EDL Sort Modes

Mode Sorts by Results in Use when

A
(Record In)

Record In timecode. Sequential editing from one 
IN point on the record tape 
to the next.

You have a short show, want 
to generate a simple, flexible 
EDL, or need to make many 
last-minute decisions.

B
(Source, Record In)

Individual source 
reel, then by the 
Record In timecode.

Checkerboard editing on 
the record reel, one source 
reel to the next.

The length of source material 
is roughly equivalent to the 
length of the finished show.

C
(Source, Source In)

Individual source 
reel, then by the 
Source In timecode.

Checkerboard editing on 
the record reel, with 
sequential playback of 
material from each source.

The length of source material 
is much greater than the 
length of the finished show.

C
(Source Start,
Source In)

Source In timecode, 
then by individual 
source reel.

Direct sequential transfer of 
source material by record 
reel. 

The length of source material 
is much greater than the 
length of the finished show.

D
(Source, Record In, 
Effects at End)

Individual source 
reel, then by the 
Record In timecode. 
Sorts effects at the 
end.

Same as B, but with all 
effects saved for the end.

The length of source material 
is roughly equivalent to the 
length of the finished show, 
and there are many special 
effects.
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Setting Up a Master List

In the Master List area of the Options window (see Figure 2-2), you can 
specify the master start event, reel ID type, timecode type, whether to 
convert reel IDs to numbers, and whether to include a source table. 
Table 2-5 explains the master list options.

E
(Source, Source In, 
Effects at End)

Individual source 
reel, then by the 
Source In timecode. 
Sorts effects at the 
end.

Same as C, but with all 
effects saved for the end.

The length of source material 
is much greater than the 
length of the finished show, 
and there are many special 
effects.

S
(Source Start)

Source In timecode 
only.

Direct sequential transfer of 
source material, in 
matching order on the 
record reel.

Completing one-light
transfers.

Table 2-4 EDL Sort Modes (Continued)

Mode Sorts by Results in Use when

Table 2-5 Master List Options

Option Procedure Suboption Notes

Master Start 
Event

Change the master start 
event number by typing 
in the text box.

The highest number accepted by 
most edit controllers is 999. You 
should not need to change this 
number.

Reel ID type Click to open the pop-up 
menu, then select the reel 
ID type.

n If you change the reel ID, you 
must reload the sequence from 
the bin, OMFI file, or Record 
monitor.

Tape Uses the reel ID from the tape 
source from which you digitized 
your video.
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Sound roll Uses the reel ID from the sound 
roll source, such as digital 
audiotape (DAT) (if you entered 
this information in the bin). Used 
for film projects.

Camera roll Uses the reel ID from the camera 
source (if you entered this 
information in the bin). Used for 
film projects.

AUX Sources 1–4 Uses the reel ID from various 
auxiliary sources (if you entered 
this information in the bin).

Timecode type Click to open the pop-up 
menu, then select the 
timecode type.

n EDL Manager can access only 
those types of timecode that are 
present in your bin.

Address (LTC) Uses the longitudinal timecode of 
the source from which you 
digitized.

VITC Uses the vertical interval timecode 
of the source in your bin from 
which you digitized.

Sound TC Uses the timecode from the sound 
source, such as DAT or Nagra, 
from which you digitized. Used for 
film projects.

Film TC Uses the timecode from the film 
source in your bin.

Aux 1–5 TC Uses the timecode specified in the 
timecode column in your bin.

Table 2-5 Master List Options (Continued)

Option Procedure Suboption Notes
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Setting Up a Dupe List

A dupe reel is a compilation of the duplicate clips that you need to 
conform a sequence, or make the final show from your editing. If you 
have clips that a transition effect joins from a single tape, you need to 
dupe a clip so that another source tape exists to transition to and from, 
as one tape cannot be in two places at once. The second source tape is 
called a B-roll. 

The following figure illustrates the use of dupe clips and a B-roll:

A dupe list is a list of dupe clips. The editor conforms the dupe list onto 
a separate tape, which is then used as a source when editing the final 
show from the master list.

Convert to 
Numbers

Click to select or deselect. If you select Convert to Numbers, 
the EDL you generate always uses 
numbers for reel IDs, even if your 
edit controller uses alphanumeric 
tape names.

Incl. source table 
w/ saved EDL

Click to select or deselect. Includes the source table 
information whenever you save an 
EDL.

Table 2-5 Master List Options (Continued)

Option Procedure Suboption Notes

Sequence Shot 1, Source A Shot 2, Source A

Dissolve

Shot 2, Source AB-roll (Handle) (Handle)
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In the Dupe List/Preread area of the Options window (see Figure 2-2), 
you can set the dupe list options. Table 2-6 explains the options.

Table 2-6 Dupe List Options

Option Procedure Suboption Notes

Type Click to open the pop-up 
menu, then select the 
dupe reel type.

None Creates no dupe reel.

One, New 
Timecodes

Creates one dupe reel with a 
timecode you select.

One, Jam Sync Creates one dupe reel with 
timecodes from the original 
sources.

Multiple (B-rolls) Appends a “B” to the incoming 
source when transitions are made 
from a single source.

Preread Creates no dupe list. Adapts the 
EDL master list to accommodate 
duplicate frames as preread frames 
when editing with digital decks. 
For more information on preread, 
see “Using the Preread Option” on 
page 52.

Dupe reel name Type a name or number in 
the text box.

Preread name Type a new name in the 
text box to override the 
default name.

Used to specify the source name of 
the “to” side in a preread transition 
(see “Using the Preread Option” on 
page 52). The new name is an 
override only for the duration of 
the session.
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Using the Preread Option

Preread (see Table 2-6) is an increasingly popular choice for online 
editing because more suites now have digital decks. Preread allows an 
editor to make a transition between two segments of a single source. 
The online session requires fewer source decks, and preread virtually 
eliminates the need for dupe reels, allowing online editing to move 
more quickly. This saves both time and resources.

Without preread, a dissolve between two shots from a single source 
requires three decks: two source decks and a record deck. One of the 
shots must be dubbed out and played from a second source deck. With 
preread, the third deck and the dubbing out are unnecessary.

Starting Event Type in the text box to 
change the dupe reel’s 
starting event number.

Start Timecode Type in the text box to 
specify the starting record 
timecode of the dupe reel.

Handle Type in the text box to 
specify the length of extra 
material you include 
before and after cuts on 
the dupe reel. 

To avoid handles, set this number to 
00:00:00:00.

Dupe all 
transitions

Click to select or deselect. Forces a B-roll for every transition.

Table 2-6 Dupe List Options (Continued)

Option Procedure Suboption Notes
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n With preread edits, the cut before the transition (sometimes called the A-side, 
or outgoing footage) is overrecorded. The overrecord area must be equal to or 
greater than the duration of the transition. You specify the source name of the 
“to” side of a preread transition in the Preread name text box (see Table 2-6) 
of the Dupe List/Preread area in the Options window.

Showing or Hiding Comments and Other Information

The Show area of the Options window (see Figure 2-2) is where you 
select the types of comments and other information, generated during 
the editing of a sequence, to display in the EDL. Displaying this 
information can be helpful when conforming the program in an online 
suite.

Click an option in the Show area to select or deselect it. The selected 
options that appear in the EDL are prefixed by asterisks (*). Table 2-7 
explains the options.

Table 2-7 Show Options

Option Description

Comments Includes comments about events in the EDL that were 
added during editing. 

Clip Names Includes names associated with the source clips in Avid 
editing system bins.

Patch Info Refers to audio patching information. Can aid during the 
manual setup of cross-channel patching.

Audio EQ Info Refers to audio equalization (EQ) information. EDL 
Manager generates comments containing EQ values 
specified for clips with audio EQ.
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c Some edit controllers might not be able to load comments 
successfully. Check with the online editor to make sure the edit 
controller can support these types of comments. If necessary, you 
can create two separate versions of the list — one without comments 
for the edit controller, and one with comments — that you can print 
for your own reference.

The Effects Info Comment

If you select Effects Info, EDL Manager generates a comment in the 
EDL that indicates the type of effect and its parameters. Effect types 
available in EDL Manager are:

• Picture-in-Pictures

• Superimpositions

• Masks

• Resize and Blowup

• Flip, Flop, and Flip-Flop

Pan/Volume Info Displays pan and volume levels in each event: pan levels 
are measured in percentages left and right of center, and 
volume is measured in +/– decibels.

Effects Info Refers to information about special effects; for more 
information, see explanation in “The Effects Info 
Comment” on page 54.

Repair Notes Indicates modifications made to the EDL by EDL 
Manager; for more information, see “The Repair Notes 
Comment” on page 55.

Locators Includes locator text added to the sequence during 
digitize.

Table 2-7 Show Options (Continued)

Option Description
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• Color Effects

• Film Dissolves

• Film Fades

• Fades to Color

• Fades from Color

• Keys

• Wipes

• Rolling and crawling titles

For more information on effects, see your Avid editing system 
documentation.

The Repair Notes Comment

Repair notes indicate changes EDL Manager makes to handle a 
complex EDL or discrepancies EDL Manager finds in the sequence. If 
you select the Repair Notes option, EDL Manager displays changes 
that it makes, such as limiting the number of frames in a dissolve or 
invalid Source In times.

The following example shows two repair notes:

For more information on the use of repair notes, see “Removing 
Problems Caused by Complex Sequences” on page 65.

Example 
of repair 
notes
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Optimizing the EDL

Optimization is a process that simplifies your EDL. An optimized EDL 
contains simplified text, and events that are combined or condensed to 
speed up the online assembly process. 

For example, if two tracks of video and one channel of audio share the 
same Record In and Record Out timecodes, and they come from the 
same source tape, optimization expresses them as one edit instead of 
three.

In the Optimization area of the Options window (see Figure 2-2), click 
an option to select or deselect it. Table 2-8 explains the options.

 

n If you choose both Optimize EDL and Dissolves as Cuts, EDL Manager will 
display an alert message. This does not affect the sequence in your bin, OMFI 
file, or Record monitor. You can always reset the dissolves by reloading your 
bin.

Table 2-8 Optimization Options

Option Description

Optimize EDL Allows optimization to occur. 

Dissolves as Cuts Changes all dissolves to cuts.

Wipes as Cuts Changes all wipes to cuts.

Include Black Edits Includes filler as black edits (video only). Choose this 
option to have Cuts to Black appear in your EDL.

Audio Dissolves as 
Cuts

Changes all audio dissolves to cuts.
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Setting Up Standards

The Standards area of the Options Window (see Figure 2-2) includes 
the broadcast standards, number of supported audio channels, and 
switcher settings.

To set Standards options:

t Click an item in the Standards area to open the pop-up menu, and 
then select the option you want. Table 2-9 explains the options.

Table 2-9 Standards Options

Option Suboption Description

Standard NTSC Use for video projects or for film projects 
in which video and audio were transferred 
and digitized at 30 frames per second (fps) 
using pulldown.

PAL Video Use exclusively for video projects.

PAL Film 1 Use for film projects in which video and 
audio were transferred and digitized 
together at 25 fps. 

PAL Film 2 Use for film projects in which video and 
audio were transferred and digitized 
separately at different speeds.

Switcher EDL Manager supports the SMPTE 
switcher, and a number of GVG and Sony 
switchers.
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n If you open an OMF file or a file from a bin, EDL Manager automatically 
determines whether the EDL you are generating should be NTSC, PAL Video, 
or PAL Film 1 or 2. However, if you open an EDL other than from an OMF 
file or file from a bin, you must select a standard suboption.

Setting the Record Start Time

The Record Start Time area of the Options window (see Figure 2-2) 
allows you to base the record start time on either of the following 
options:

• The sequence currently active in your Avid video-based editing 
system.

• The time that you specify. 

To specify a time:

t Type a time in the Other text box.

Audio Channels 4 Use for selecting the number of channels. 
For a list of edit controllers and the 
number of supported audio channels, see 
Table 2-3.

16 Use this setting for Cuedos controllers and 
Avid systems. If you choose 16 channels, 
the tracks display changes to reflect your 
choice. For a list of edit controllers and the 
number of supported audio channels, see 
Table 2-3. 

Table 2-9 Standards Options (Continued)

Option Suboption Description
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Setting the Pulldown Start Frame

The Pulldown Start Frame area of the Options Window (see 
Figure 2-2), used with 24p and 25p projects, allows you to choose the 
start frame for your generated EDL. 

To set the pulldown start frame:

t Choose one of the following options from the pulldown menu:

• Sequence — default setting, based on start frame set in 
sequence

• A Frame — sets pulldown start frame to A

• B Frame — sets pulldown start frame to B

To see the pulldown start frame in the EDL:

t Select the Show Pulldown Comment option.

The following example shows the pulldown start frame:

Setting the Tapename Truncation

The Tapename Truncation area of the Options window allows you to 
determine which part of the tapename you want to save.
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To set the tapename truncation:

t Choose one of the following options from the pulldown menu:

• Trunc. End

• Remove Middle

• Remove Beginning

• First Char. + End

Table 2-10 describes these options.

Table 2-10 Tapename Truncation Options

Option Example Description Use When

Trunc. End CHICAGO138101 
becomes 
CHICAGO1.

Truncates the end of the tape 
name. This method is the 
default.

Distinguishing segment of 
tape name is at the 
beginning.

Remove Middle CHICAGO138101 
becomes 
CHIC8101.

Takes half of the allowed 
number of characters from 
the front and the other half 
from the end of the tape 
name. 

Sequentially numbered 
series of tape names, such as 
CHICAGO138100, 
CHICAGO138101, and so 
forth.

Remove Beginning CHICAGO138101 
becomes 
GO138101.

Removes the beginning of 
the tape name. 

Distinguishing segment of 
tape name is at the end, such 
as tape names with very 
long numbers in a large 
library system.

First Char. + End CHICAGO138101 
becomes 
CO138101.

Keeps the first character and 
the last characters and 
removes everything in 
between.

Distinguishing segment of 
tape name is at the end.



61

Saving Options to a Template File

To save your customized options as a template:

1. Make changes to any of the option settings as described in this 
chapter. 

2. Click one of the following buttons:

• Apply — saves your settings to a temporary template and 
brings the EDL Manager window to the front. The italicized 
name of the temporary template appears in the Template 
pop-up menu of the EDL Manager window. The template 
remains temporary until you click the Save As button and 
provide a file name.

• Save As — saves the options to a new template. A dialog box 
opens in which you can provide a file name for the template. 
The new name appears in two places:

– In the Template pop-up menu in the EDL Manager window

– In the Template Name text box of the Options window

3. Click the Revert button to discard your changes and reinstate the 
options of the current template file.

Changing Options in the Site Settings Dialog Box

You can change serial transmission, list font, and printer font options 
in the Site Settings dialog box. 

To open the Site Settings dialog box:

t Choose Site Settings from the Edit menu. 
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Changing Serial Transmission Options

Set up serial transmission options only if you will be transferring an EDL 
to an online editor by means of serial transmission. For information on 
using the Site Settings dialog box to define the serial transmission and 
options, see Appendix C.

Changing Font Options

The List Font and Printer Font tabs in the Site Settings dialog box 
allow you to change the font and size of the text in your EDL. The List 
Font tab affects the on-screen display; the Printer Font tab affects the 
printed version of the EDL. 

To change the font and font size of your EDL text:

1. Click either the List Font or Printer Font tab, depending on which 
font you want to change.

2. Choose a font from the Font pulldown menu.

3. Type a number in the Font Size text box. 

4. Click OK.
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CHAPTER 3

Editing and Troubleshooting 
EDLs

You can edit an EDL with a text editor to clean up the EDL for a 
successful reading. You can also troubleshoot EDLs by using 
techniques described in this chapter.

This chapter includes the following sections:

• Using a Text Editor to Edit an EDL

• Removing Problems Caused by Complex Sequences

• Locating Trouble Spots

• Avoiding Problems in EDLs

Using a Text Editor to Edit an EDL

You can use a text editor to delete or change information in the EDL 
that might not read correctly into EDL Manager. 

c Before you edit, create a copy of the EDL. Edit the copied EDL rather 
than the original. You can then revert to the original if you make 
errors.
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c When you edit the EDL, be careful to delete only the information 
you want to delete; do not delete any extra characters. If you delete 
extra characters, you might see further errors when you try to read 
the EDL again.

The following sections describe possible edits you can make to clean 
up the EDL for successful reading. To make sure EDL Manager can 
read your EDL, complete the following procedures. If the first 
procedure does not solve the problem, proceed to the next.

Fitting the Format to the EDL Manager

If you are having trouble reading a list in EDL Manager, the list might 
not meet EDL Manager formatting requirements. The following is a 
check list of the most common formatting problems:

t Check the format layout. 

Make sure the columns are in the correct place and the characters 
are correct for your edit controller. If you use an editor that can 
display hidden characters, turn on that feature to view spacing, 
tabs, and carriage returns more easily. If you are unsure about the 
layout, see the edit controller documentation from the online suite. 

t Check reel names and numbers.

Make sure they are the appropriate length for your edit controller. 
If you are unsure about the layout, see the edit controller 
documentation from the online suite.

t Delete all general-purpose interface triggers. 

These triggers, labeled GPI, cause problems reading into 
EDL Manager.

t Delete any Master/Slave comments. 

These comments, preceded by the MS symbol, cause problems 
reading into EDL Manager.
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t Change the source names in the EDL from Aux and Black to an 
unused reel number. 

When you create a new EDL, this new number will represent Aux 
and Black. You need to do this because EDL Manager reads only 
numbers, not letters.

Changing the Header Format

Sometimes the EDL does not read properly because the EDL Manager 
does not recognize the header format. This might happen if you use an 
EDL not generated by an Avid video-based editing system. If this is 
the case, you can replace the unreadable header with an EDL header 
generated by the Avid editing system.

To make sure the header format matches the EDL:

1. Delete the current header from the EDL you are trying to read. 

2. Generate a list in EDL Manager that is the same format as the EDL 
you are trying to read. 

3. Open an EDL generated by an Avid video-based editing system 
and copy the EDL headers.

4. Paste the EDL headers into the EDL you are trying to read.

Removing Problems Caused by Complex 
Sequences

When a sequence is too complex for the EDL Manager to describe, it 
generates error messages and tries to simplify the sequence. This 
happens most frequently when you try to generate a list for a sequence 
that has multiple video tracks. 

EDL Manager’s attempts at simplifying complex sequences are 
pointed out in the repair notes and appear as comments within the list.
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You can avoid having EDL Manager simplify your composition by 
requesting a separate list for each video track. This is known as track 
isolation. Or you can delete comments and motion effects that might be 
causing problems.

Using the Console Window to Display Messages

To display EDL Manager messages:

t Choose Console from the Windows menu. 

The Console window opens.

Command text box

Message area

Recall button

Repeat button
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To get help about console commands: 

t Type the Help command in the Command text box, and then press 
Return.

A description of how to use the Help command appears in the 
message area.

To display a previous command in the Command text box:

t Click the Recall button (F3). 

To perform a previous command:

t Click the Repeat button (F2). 

To clear the display:

t Click the Clear button. 

Always check the Console window after making a list. Error messages 
appear in the Console window if certain comments or events cause 
problems.

EDL Manager generally identifies motion effects by M1, M2, and so 
on.

c Do not use the programming functions of the Console window 
without the guidance of an Avid professional. If you need help 
interpreting information in the Console window, contact your local 
Avid Reseller; in North America, you may call Avid Customer 
Support at 1-800-800-AVID (2843).
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Fixing Difficult Transitions

Specific transitions can cause difficulties for the EDL Manager. For 
example, a color effect on a resized motion-controlled clip that 
dissolves to an imported graphic file will overwhelm the EDL 
Manager’s descriptive capacities, forcing a repair note. Less obvious 
complexities can also affect list generation.

You can best resolve these problems by isolating the offending 
transitions and simplifying or removing them.

Locating Trouble Spots

You can isolate trouble spots in several ways. They include slicing and 
dicing, and trying one track at a time.

Slicing and Dicing

The most effective method for finding trouble spots is slicing and 
dicing the sequence. Slicing and dicing isolates trouble spots by 
dividing sequences in half and testing for successful generation. 

To slice and dice the sequence with your Avid video-based editing 
system:

1. Load the sequence into the Source monitor.

2. Mark an IN point at the head frame and an OUT point halfway 
through.

3. Cut this portion over to the Record side.

4. Test this portion of the sequence by creating an EDL.
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If the EDL is generated successfully, you know that the problem is in 
the second half of the sequence. If not, subdivide the sequence 
elsewhere to further isolate the source of the problem.

To subdivide the sequence:

1. Press Ctrl+Z (Windows) or Command+Z (Macintosh) to clear the 
sequence from the Record monitor (so you will not accumulate 
“Untitled Sequence.01...02...03” in your bin).

2. Load the unsuccessful half into the Source monitor, and repeat 
steps 2 through 4 in the preceding procedure.

Trying One Track at a Time

Another way to isolate trouble spots is to generate an EDL by using 
one track at a time. The problem might be on a particular track. For 
information on isolating tracks, see “Combining or Isolating Tracks” 
on page 35.

Avoiding Problems in EDLs

You can help resolve problems by trying the following:

• Simplifying Effects

• Looking for Missing Information

• Dealing with Corruptions

Simplifying Effects

You can simplify effects in your sequence that are overly complex. For 
example, you can remove a color effect from a resized segment. Use 
comments to help re-create the original sequence in the online suite.
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Looking for Missing Information

Occasionally, EDL Manager fails to generate a list because clips in the 
sequence are missing information essential to the EDL (for example, 
you try to create an audio list by using clips lacking audio timecode).

Try the following suggestions if you suspect a problem caused by 
missing information:

• Scan your bins for any obvious omissions of files you need for 
your sequence.

• Use the slice and dice technique to isolate difficulties.

• In your Avid video-based editing system, find the overlap frame 
of troublesome clips, then use the Find Bin command to check 
their statistics.

• Add information to the bin as needed.

Dealing with Corruptions

List generation can be hampered by corruptions. These are areas where 
information relating to a clip or transition has become damaged or 
lost, preventing the system from describing it in an EDL. In extreme 
cases, corruption prevents the clip from playing. The most effective 
way of dealing with corruptions is to cut them out and replace them.

Scrupulously backing up a project can reward you if you encounter 
corruptions. Using an earlier, uncorrupted version of a sequence that 
does not exhibit the corruption can save you considerable time.
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APPENDIX A

Check List for Online 
Editing

When you move from nonlinear to linear editing systems and generate 
EDLs to help re-create your sequence online, you might encounter 
some obstacles. For example, an EDL generated in one format might 
be incompatible with the edit controller at the online suite. Or, you 
might be unaware of the dupe reel characteristics your EDL should 
contain. Problems like these might result in an unproductive and 
costly online session.

This appendix contains a list of suggestions to help you avoid or 
minimize problems.

• Calling Ahead to the Online Suite

• Deciding What to Take to the Online Suite

• Double-Checking the EDL File Names

If you have questions, contact your local Avid Reseller; in North 
America, you may call Avid Customer Support at 800-800-AVID 
(2843).
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Calling Ahead to the Online Suite

Before you finish working offline, call the online suite to find out:

• What types of edit controllers the suite has. Find out all the 
different types in case you are assigned to one edit controller but 
end up using another when you get there. If possible, go to the 
suite, look at the equipment, and determine the appropriate EDL 
format.

• Whether the edit controller reads high-density or low-density 
(double-density) disks.

• What EDL format the controller reads. CMX_3600 format is read 
by most edit controllers. If you are unsure what type of edit 
controller the suite uses, save the EDL in several different formats. 
If you have trouble with one format, you will have other formats 
from which to choose. 

• If the computer system at the online suite reads 3.5-inch disks. 
Some older computers use only 5.25-inch or 8-inch disks, and very 
few newer computers can read or write to these types of disks.

• If you need to generate a dupe reel list with new timecodes or a 
multiple B-roll list in EDL Manager. Also, find out if any other 
information is required for your project and that you should 
include as a comment in the EDL.

• If the online suite can create all the effects you specified in the 
EDL. If not, consider regenerating the EDL and adjusting the 
options.

• If you can send a preliminary version of the EDL ahead of time to 
make sure it loads properly on the edit controller. If it does not, 
you can make the necessary adjustments.

• The name of the switcher in the online suite. If you are not sure 
which switcher is being used, adjust the Switcher setting in 
EDL Manager to SMPTE. (The switcher setting is in the Options 
window.)

• If the suite has a computer you can use.
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Deciding What to Take to the Online Suite

Consider taking EDL Manager, several forms of your EDL, and 
reference information to the online suite.

Take EDL Manager

If possible, take EDL Manager with you, along with the bins on a disk. 
You can use EDL Manager on a computer running the Windows or 
Macintosh operating systems. If you do not have a portable computer, 
call ahead to find out if you can load EDL Manager from a CD-ROM 
onto a computer at the suite.

Take the EDL in Several Forms

Having your EDL in several forms allows greater editing flexibility. If 
difficulties arise, you can refer to a paper copy. Take the EDL in the 
following forms:

• Saved on 3.5-inch disk

• Printed on paper (in A-mode sort for easy reference)

For more information on saving and printing, see “Saving an EDL” on 
page 19 and “Printing an EDL” on page 23.
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Take Reference Information

You might also want to take as a reference one of the following:

• A digital cut. For more information, see the user’s guide for your 
Avid video-based editing system.

• An audio layback (AudioVision® only). For more information, see 
the Avid AudioVision User’s Guide.

• A printout of the source table.

Double-Checking the EDL File Names

Make sure the EDL file names are the correct length and type for the 
disk format in which you saved them. Follow these guidelines:

• If you save your EDL to a disk formatted for CMX or GVG, the file 
name must have six or fewer uppercase alphanumeric characters 
followed by the file name extension .EDL. There can be no spaces 
in the file name, and no characters except letters and numbers.

For example, TEST1.EDL is a valid file name for GVG and CMX 
systems.

• If you save your EDL to a DOS-formatted disk, make sure the file 
names are no more than eight uppercase alphanumeric characters 
followed by the .EDL file name extension. Again, the file name 
must not contain spaces or other special characters; only letters 
and numbers are acceptable.

For example, WINSTON3.EDL is a valid file name for 
DOS-formatted disks.
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APPENDIX B

Creating EDLs for Film 
Projects

This appendix explains several things to consider when you create 
EDLs for film projects. It includes the following sections:

• Matchback Conversion in Film-to-Video EDLs

• Creating EDLs for a Matchbacked Sequence

• Creating Audio-Only EDLs

Matchback Conversion in Film-to-Video EDLs

If you are editing a film project with an Avid video-based editing 
system, you might intend to finish the project in video. The matchback 
conversion process requires the editing system to perform special 
calculations to match the film to video. Because the ratio of 
film-to-video frames is uneven, the film and corresponding video edit 
points do not line up evenly.

For example, with a ratio of 24 film frames to 30 video frames, a 
6-frame film edit corresponds exactly to a 7 1/2-frame video edit. 
However, video edits cannot include partial frames, so the video edit 
must be 7 or 8 frames long.
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Because video edits might be longer or shorter than the original film 
edits, the system makes sure the film and video sequences match as 
closely as possible by checking the durations at the end of each edit. If 
the total video-sequence duration is a frame longer than the film, the 
system will subtract a frame from the last video edit. If the video is a 
frame too short, the system adds a frame to the last video edit. 

Creating EDLs for a Matchbacked Sequence

When you create an EDL for a sequence that converts from film to 
video, an edit listed in the EDL might be slightly longer or shorter than 
the corresponding film edit. The EDL might not be an exact 
representation of the sequence — it can be plus or minus one frame, in 
accordance with the 30 to 24 frames per second (fps) matchback 
conversion. In this case, be aware of the discrepancy when you go to 
the online suite so that you can adjust for the difference.

NTSC

Film

Edit

The corresponding video edit point does not fall 
exactly on the boundary between two video frames.
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Creating Audio-Only EDLs

If you create an audio-only EDL for a film project, set the following 
options in the EDL Manager Options window before you generate the 
list:

• Dissolves as Cuts (Optimization area)

• Sound Roll as the Reel ID type (Master List area)

• Sound TC as the Timecode type (Master List area)

These options simplify the EDL, and ensure that the pertinent source 
information is referred from the bin to the EDL.
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APPENDIX C

Using Serial Transmission to 
Transfer EDLs

If your offline and online editing suites are in the same building, or if 
you are transferring the EDL to an edit controller that has no disk 
drive, consider using serial connections to transmit EDLs from offline 
to online.

This appendix contains the following sections:

• Connecting the Edit Controller to the Computer

• Setting Serial Transmission Options

• Transmitting the EDL

Connecting the Edit Controller to the Computer

To connect the edit controller and your computer:

1. Decide which port on the edit controller you will use for 
transmission.

2. Connect the serial port on the computer to the port on the edit 
controller that you have chosen to use for transmission. 
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Setting Serial Transmission Options

Before the edit controller and computer can communicate, you must 
specify various options in EDL Manager. 

To set the serial transfer options:

1. Choose Site Settings from the Edit menu.

The Site Settings dialog box appears.

2. Select an option from the pop-up menus. Table C-1  explains the 
options.

3. Click OK to apply your changes to your EDL.

4. Click OK to implement the options you have selected.
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Table C-1 explains the serial transfer options.

Table C-1 Serial Transfer Options

Option Description

Port Indicates the system port. The items on this pop-up 
menu vary depending on your system’s ports.

Data Width Indicates if 7-bit words or 8-bit words are being 
transferred — the default is 7 bits.

Parity Indicates error detection, found through counting the 
number of bits in a transmitted word. Even indicates 
the number of bits in a word is even. Odd indicates the 
number of bits is odd. The default is zero.

Baud Rate Sets the data transmission rate for the computer on 
which EDL Manager is running — the default is 9600.

Stop Bits Indicates how many bits are needed to make a break in 
transmission — the default is 0 stop bits.

Handshaking Allows communication between two systems — the 
default is none. Options include DTR and XON/XOFF.
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Transmitting the EDL

When you are ready to transmit the EDL, another person should be 
ready at the edit controller to help you.

To transmit the EDL, do the following at the same time:

• Have the other person press Receive at the edit controller.

• Choose Transmit EDL from the EDL Manager File menu.

When you see events scrolling one by one onto the edit controller 
screen, the transmission was successful.

If you see either an error or strings of indistinguishable text, the serial 
parameters were set incorrectly in EDL Manager. Check the 
parameters for the serial port and reset them in the Site Settings dialog 
box.
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Glossary

24p or 25p 24-fps or 25-fps progressive media. The progressive media file is 
composed of single frames, each of which is vertically scanned as one 
pass. The Avid system creates 24p or 25p media by combining 
(deinterlacing) two video fields into a single full, reconstructed frame. 
For NTSC film-to-tape transfers, the system creates 24p or 25p media 
by undoing the 2:3 pulldown inserted by the telecine process, 
removing the extra fields, and creating progressive frames.

bin A database in which master clips, subclips, effects, and sequences are 
organized for a project in an Avid editing system. A file structure that 
contains other files, including sequences, and is analogous to a folder 
or a directory in other computer applications.

black edits 1. A video source with no image. 

2. A special source you can fade into, out of, or use for other effects.

B-roll An exact copy of the A-roll original material, or new original material 
on a separate reel, for use in A/B-roll editing.

CMX Edit controller made by CMX Corporation (originally a joint venture 
by CBS® and Memorex®). CMX uses its own proprietary format EDLs 
(340, 3600).
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composition The standard term used by OMF Interchange® to refer to an edited 
sequence made up of a number of clips. The OMF equivalent of a 
sequence in an Avid editing system.

conform To make the final show based on the editing. Conforming organizes 
the source material for final assembly.

corruptions Information relating to a clip or transition that has been damaged or 
lost, preventing EDL Manager from describing the information in an 
EDL. The solution is to cut the corruptions out and replace them with 
a backup version of the sequence.

cut An instantaneous transition from one video source to another. Also, a 
section of source or record tape.

dissolve A video or audio transition in which an image from one source 
gradually becomes less distinct as an image from a second source 
replaces it.

dupe list A list of dupe reels. A view of this list is available only if options are 
set for creating a dupe list. You can set the options in the EDL Manager 
Options window.

dupe reel A reel designated for the recording and playback of dupes (duplicate 
shots) during videotape editing. You create dupe reels as backup 
copies, to help in the creation of special effects, and for A/B-roll 
editing. 

edit controller An electronic device, often computer-based, that allows an editor to 
precisely control, play, and record to various videotape machines. The 
edit controller keeps track of timecodes for each shot and coordinates 
the machines in the suite: videotape machines, monitors, an audio 
mixing board, a videotape switcher, and other peripheral devices.

See also suite.
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EDL Edit Decision List. A list of edits you have made. You generate, 
customize, and optimize it in the EDL Manager, then take it with the 
source tapes to an online edit controller for final assembly of your 
show or program.

event A number assigned by the editing system to each performed edit. In 
most computer editing systems, defines an action or a sequence of 
actions performed by the computer in a single pass of the record tape.

fade A dissolve from full video to black video or from full audio to no 
audio, or vice versa.

fps Frames per second, pronounced “fips.”A measure of the film or video 
display rates. (NTSC = 30 fps; PAL = 25 fps; SECAM = 25 fps; 
Film = 24 fps.)

GVG An edit controller made by Grass Valley Group and that uses a 
proprietary format for EDLs.

handles Additional source material before and after edit points; you use a 
handle for later adjustments.

import ID The internal identification for your Avid source tape.

linear editing Tape editing in which you assemble the program from beginning to 
end. If you require changes, you must rerecord everything 
downstream of the change. The physical nature of the medium (for 
example, analog videotape) dictates how you must place material on 
the medium.

See also nonlinear editing.

master list A list that specifies the starting event number, reel ID options, and 
timecode options.

matchback 
conversion

The conversion from film to video frame rates.
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nonlinear editing A type of editing in which you do not need to assemble the program 
from beginning to end. The physical nature of the medium and the 
technical process of manipulating that medium do not enforce or 
dictate how the material must be physically ordered. You can use 
nonlinear editing for traditional film cutting and splicing, and 
digitized video images. You can make changes at the beginning, 
middle, or end of the sequence.

See also linear editing.

NTSC National Television Standards Committee. The group that established 
the color television transmission system used in the United States. The 
standard calls for 525 lines of information scanned at a rate of 
approximately 30 frames per second.

offline editing Nonlinear editing, usually done on a low-cost editing system, using 
digitized work tapes. This preliminary or rough-cut editing allows 
you to make edit decisions before performing the final edit.

OMFI Open Media Framework Interchange format. A standard format for 
the interchange of digital media data among heterogeneous platforms. 
The format is designed to encapsulate all the information required to 
interchange a variety of digital media, such as audio, video, graphics, 
and still images as well as the rules for combining and presenting the 
media. The format includes rules for identifying the original sources of 
the digital media, and it can encapsulate both compressed and 
uncompressed digital media data.

online editing The final editing using the original camera tapes and an edit decision 
list (EDL) to produce a finished program ready for distribution; 
usually associated with high-quality computer editing systems. 
Offline editing often precedes online editing, but in some cases 
programs go directly to the online editing stage.

See also edit controller.
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optimization The process that simplifies your edit decision list. EDL Manager 
simplifies the text and combines or condenses events to speed up the 
online assembly process.

overrecord To use a long shot from one reel, then place shots from other reels over 
the continuous shot.

PAL Phase Alternating Line. A color television standard used in many 
countries. PAL consists of 625 lines scanned at a rate of 25 frames per 
second.

patching The routing of audio or video from one channel or track in the 
sequence to another.

preread To read information from a tape passing under the play head of a 
videotape machine before it passes under the record head. Information 
can be read from the tape before the information is replaced. On digital 
video decks, the information gathered by the play head is stored in a 
digital buffer; the edit controller can use it as a virtual source, taking 
the place of a second tape deck in a transition.

reel ID The reel identification (ID) EDL Manager uses to refer to the master 
reel source. The reel ID can come from tape, sound roll, camera, or 
auxiliary sources.

RT-11 A disk format used to store EDLs read by CMX and GVG edit 
controllers.

serial transmission 
options

The options you set to transmit your EDL over serial connections to an 
online edit controller. Options include port, data width, parity, baud 
rate, stop bits, and handshaking.

slicing and dicing Isolating trouble spots in a sequence by repeatedly dividing the 
sequence in half, creating an EDL for the isolated half, and testing for 
successful generation.
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SMPTE Society of Motion Picture and Television Engineers. One of the 
principal standards organizations for the film and video industry.

See also timecode.

sort mode The mode that controls the auto-assembly process, determining in 
what order the edit controller reads the edit decision list, and 
assembles the final tape. There are six different types of sort mode: A, 
B, C, D, E, and S.

source table The list of the source tapes you use to create the sequence the EDL 
describes. The source table includes three kinds of information: your 
name for a tape, the Avid name for the same tape, and the Avid 
internal identification for your Avid source tape.

suite Standard industry name for the site of editing. A room or rooms 
containing such equipment as the edit controller computer, videotape 
machines, monitors, an audio mixing board, a videotape switcher, and 
other peripheral devices.

super Superimposition. One shot half-dissolved over another.

template A set of EDL Manager options saved under a specific name. You can 
use templates to save settings you use frequently and apply them 
quickly.

timecode An electronic indexing method for editing and timing video programs. 
Timecode denotes hours, minutes, seconds, and frames (00:00:00:00) 
elapsed on a videotape.

Address track timecode is recorded simultaneously with the video 
picture. Longitudinal timecode (LTC) is recorded on an audio track. 
Vertical interval timecode (VITC) is recorded in the vertical blanking 
interval of the video track. SMPTE timecode is the prevalent standard.
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Other timecodes include film timecode and audio timecode used 
during film projects. During editing, an Avid editing system can 
display and track several types of timecode.

See also SMPTE.

track isolation The process of creating a separate list for each video track to simplify 
the composition.

wipe A shaped transition between video sources in which a margin or 
border moves across the screen, wiping out the image of one scene and 
replacing it with another.
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Numerics
24p and 25p projects 40
24p projects 38

A
All Video setting 35
Apply options 61
Audio channels

See also Tracks
choosing format for 36
defining 32
mixing down 46
selecting 32
standards options in EDLs 58
support in edit controllers 44

Audio Dissolves as Cuts option 56
Audio layback 74
Audio-only EDLs

creating 77
Avid editing system

creating a sequence from an EDL on 26
creating an EDL from a sequence on 25
using EDL Manager with 25

B
Backing up projects 70
Bins

creating EDLs from 12
Black edits 56
Broadcast standards

options in EDLs 57
settings for 57

B-roll 50

C
Changing

header format 65
Changing EDL titles 31
Changing settings

in the EDL Manager window 30
in the Options window 42

Channels, audio
choosing format for 36
defining 32
mixing down 46
selecting 32
standards options in EDLs 58
support in edit controllers 44

Check list for online editing 71

Index
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Choosing audio channel format 36
Clip Names option 53
CMX format

for RT-11 disks 22
Combining tracks 35
Comments in EDLs

showing or hiding 53
Complex sequences 35, 65
Composer

using EDL Manager with 25
Console window

using to display messages 66
Controllers

connecting to a computer 78
defining tracks and channels for 32
format for audio channels 36
selecting a format for 44
sorting events for 46
support for comments 54

Copying
EDLs between storage locations 23

Corruptions 70
Creating a sequence from an EDL 26
Creating EDLs

for matchbacked sequences 76
from a bin 12
from an active sequence 25
from an existing EDL 12
from an OMFI file 13
from sequence in bin 12
with audio only 77

Creating stereo channels 35
Customizing EDLs

in the EDL Manager window 30
in the Options window 42
in the Site Settings dialog box 61

D
Defining a track 33

Defining audio channels 32
Defining video tracks 32
Digital cut 74
Disks

See also RT-11 disk
types used in online suite 72

Dissolves as Cuts option 56
Dupe list

described 50
options in EDLs 50
view in EDL Manager window 36

Dupe reel
described 50

E
Edit controllers

connecting to a computer 78
defining tracks and channels for 32
format for audio channels 36
selecting a format for 44
sorting events for 46
support for comments 54

Editing EDLs
for successful reading 63
with a text editor 63

EDL formats
troubleshooting 64

EDL Manager
defined 10
functions 10

EDL Manager window
changing settings in 30
displaying different views in 36

EDLs (edit decision lists)
audio-only 77
changing titles of 31
creating for film projects 75
creating for matchbacked sequences 76
creating from an active sequence 25
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creating from an OMFI files 13
creating sequences from 26
customizing 29 to 61
defined 10
editing with a text editor 63
file name guidelines for 74
film-to-video matchback conversion 75
finding the edited field 40
formats supported for 44
formatting 64
optimizing 56
printing 23
reading in CMX or GVG (RT-11) format 17, 

18
saving as OMFI compositions 19
saving as text files 19
saving to RT-11 disks 20
selecting templates for 37
serial transmission 78
setting options 30
sorting 46
transmitting 81
troubleshooting 63
updating 41
verifying an RT-11 save 22
views for 36

Effects
simplifying 69
supported in EDL Manager 54

Effects Info comment 54
Effects Info option 54
Error messages 66
Events

order of 46
simplifying 56

Excluding tracks 33

F
File name guidelines for EDLs 74

File names of templates 37
Film projects

creating EDLs for 75
Film-to-video EDLs

matchback conversion in 75
Fixing transitions 68
Format header 65
Formats

selecting EDL 42, 44
supported by EDL Manager 45

Formatting requirements 64
Formatting RT-11 disks 22
Frame rates 38

G
GPI (general-purpose interface) triggers 64
GVG format

for RT-11 disks 22

H
Hardware connections

for serial transmission 78
Header format

changing 65
in EDLs 65
troubleshooting 65

Hiding or showing text 53

I
Include Black Edits option 56
Including tracks 33
Isolating tracks 35
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L
Launching EDL Manager 11
List views 36
Locating missing information 70
Locating trouble spots 68
Locators

in EDLS 54

M
Main window

changing EDL setting in 30
Master list

options in EDLs 48
view in EDL Manager window 36

Master start event 48
Matchback conversion in EDLs 75
Messages

displayed in Console window 66
Missing information

locating 68

N
Nonlinear editing systems 10
NTSC (National Television Standards 

Committee)
Options window 57

O
Offline editing

transmitting from 78
OMFI

defined 10
OMFI compositions

saving EDLs as 19

Online editing
check list for 71
defined 10

Online suite
preparing for 71
running EDL Manager at 73
transmitting to 78

Opening
template 38

Opening an existing EDL 13
Optimization

options for EDLs 56
Options

defined 29
saving 61
undoing changes 61

Options window
changing settings in 42
setting Record Start Time in 58

Order of events, sorting 46
Output and Source pop-up menus

updating changes to 41
Output and Source timecodes

adjusting 38

P
PAL (Phase Alternating Line)

PAL standards (Options window) 57
Preread option 51
Printing

EDLs 23
source tables 28

Printing list of tapes in Source table 28
Problems

header format 65
Projects

backing up 70
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R
Reading existing EDLs

in CMX or GVG (RT-11) format 17, 18
Record Start Time (Options window) 58
Repair notes

in EDLs 54, 55
Representing complex sequences 35
Revert button 61
RT-11 disk

formatting 22
reading an EDL from 17, 18
saving EDLs to 20
verifying a save to 22

S
Save As button 61
Saving EDLs

as OMFI compositions 19
as text files 19, 63
to RT-11 disks 20

Saving options to a template 61
Selecting EDL Controller formats 44
Selecting EDL settings 42
Sending EDLs
Sequences

complex 35, 65
creating an EDL from an Avid editing 

system 25
creating from an EDL 26
for an Avid editing system from an EDL 26

Serial transfer options
changing 61

Serial transmission
hardware connections for 78
of EDLs 78
options in Site Settings dialog box 61
setting options 79

Setting EDL options 30

Settings
for EDL Manager 29
for pulldown start frame 59
for record start time 58
for serial transmission 79
for tapename truncation 59
in the EDL Manager window 30
in the Options window 42
selecting a template of 37

Showing or hiding text 53
Simplifying

EDLs 56
Simplifying effects 69, 69
Site Settings dialog box, opening 61
Slicing and dicing 68
Sort mode options 46
Sorting order of events 46
Source and Output pop-up menus

updating changes to 41
Source and Output timecodes

adjusting 38
Source table

displaying list of source tapes in 36
printing 28
taking to the online suite 74
view in EDL Manager window 36

Source tapes
printing list of 28
viewing list of 27

Standards
options for EDLs 57

Start time options 58
Starting EDL Manager 11
Stereo channels, creating 35
Suite

defined 10
Suite See Online suite
Switchers

options for EDLs 57
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T
Template pop-up menu 37
Templates

described 37
file names of 37
opening 38
saving options as 61
selecting 37
temporary files 61

Temporary template file 61
Text

showing or hiding 53
Text editors

editing EDLs with 63
Timecode

adjusting 38
field where edit occurred 40
formats 41
sort mode 46

Title of EDL, changing 31
Track Selector panel

described 32
updating changes to 41

Tracks
See also Audio channels
combining 35
defining 32, 33
excluding 33
including 33
isolating 35
selecting 32
stereo, creating 35

Transitions
troubleshootng 68

Transmitting EDLs See Serial transmission
Triggers

GPI 64
Troubleshooting

complex sequences 65
corruptions 70

difficult transitions 68
EDL formats 64
EDLs 63
error messages 66
header format 65
missing information 70
simplifying effects 69
slicing and dicing 68
trouble spots 68

U
Undoing option changes 61
Update button 41
Updating EDLs 41
Using EDL Manager with an Avid editing 

system 25

V
Verifying a save to an RT-11 disk 22
Video tracks

See also Audio channels
combining 35
creating stereo 35
defining 32, 33
excluding 33
including 33
isolating 35
selecting 32
updating 41

Viewing list of tapes in Source table 27
Views of an EDL 36

W
Wipes as Cuts option 56
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